NicelLabel

NiceForm User Guide
(PowerForms)

English Edition
Rev-1409
© 2014 Euro Plus d.o.o. All rights reserved.

Euro Plus d.o.o.

Poslovna cona A 2
SI-4208 Sencur, Slovenia
tel.: +386 4 280 50 00
fax: +3864 233 11 48
www.nicelabel.com
info@nicelabel.com



http://www.nicelabel.com/
mailto:info@nicelabel.com




Table of Contents

Table of Contents ... . . . L 3
Introduction ... . 7
About this manwal .. 7
Conventions used in this Manual ... . 7
Welcome to NiceForm .. 7
Setting up the Application .. . 8
User Interface .. i 8
Basic and Advanced User Interface ... .. ... 8
Keyboard Shorteuts ... 8
Status bar .. 9
To0lbars L 9
Form Security il 9
Locking Form . .. 9
Designing FOrms .. 11
Using Toolbars .l 11
Using Database Toolbar ... ... 11
Using Standard Toolbar ... . 11
Using Text Toolbar ... .. . i, 12
Using ToolboX ... .. . 12
Using Transformations Toolbar ... ... 13
Using Variable Toolbar .. . 13
Working with Objects ... . 14
Working with Buttons ... ... 14
Defining AcCtions ... il 14
Browse for File or Folder ... ... . . . . i, 14

Close Label _ . il 14
Define Printer Settings .. ... ... . .. 15
Execute SCript ... e 15
Execute SQL Statement ... 15

For Every Label ... il 16

For Every Recordina Table ... ... . 17

FOr LoOp ... o 17
Import Data Into Database ... .. i 17

Load Variable Data . .. i 18

Move Focus to Object ... . .. e, 18

Open Another Form ... .. . 19

Open Document/Program ... .. ... ... e, 19

Open Label ... 20

Print Label ... e 20

Read Data from Serial Port .. ... . i, 20
Refresh Database ... ... ... i 21
Refresh Previews ... ... e 21

Run Command File ... ... e, 21

Save Variable Data .. ... 22

Select Variables ... .. 22

Send Custom Commands ... .. il 22

Send Data to TCP/IP . . 22




Set Variable . . 23
View Log File . .. 23
Verify License ... 24
Write Data to Serial Port ... 24
QU il 24
Creating the Button ______ . 24
Working with Button Group ... .. ... 25
Creating the Button Group ... ... 25
Working with Check Boxes ... ... . 25
Creating the Check Box ... . 25
Working with Combo Boxes ... ... . . ... 26
Working with Combo Box ... ... il 26
Working with Database Navigator ... ... ... 27
Creating the Database Navigator ... ... 27
Working with the Database Navigator _____ . ... 27
Working with Database Search ... .. 28
Creating the Database Search . ... 28
Working with the Database Search __ . ... 28
Working with Edit Fields ... . . .. 28
Creating the Edit Field ... ... 28
Working with Frame Objects ... . ... .. il 29
Creating the Frame Object .. ... . 29
Working with List BoXes ... .. .l 29
Creating the List Box ... .. 29
Working with Memo Fields ... . .. 30
Creating the Memo Field ... ... 30
Working with Pictures ... . 31
Creating the Picture Object ... ... 31
Working with Previews . 31
Creating the Preview .. ... e 31
Working with Radio Groups ... . 31
Creating the Radio Group ......... ... ... e 31
Working with Tables ... . 32
Create the Table Element _ il 32
Formatting Table Object . .. 33
Linking Fields with Variables . ... 33
Using Master - Detail Connection __ ... . ... 33
Working with Text Objects ... . ... .. i, 34
Creating the Text Object .. .. 34
Working with Variable Prompts ... ... ... 34
Working with the Variable Prompt ... ... ... 34
Aligning Objects on the Form ____ . ... 35
Moving and Resizing Objects ... . . .. 35
Selecting Objects ... . . L 35
Working with Variable Data .. .. 36
Contents Providers ... ... L 36
Contents Providers ... . il 36
Working with Databases ... . 36
Database Wizard . il 36
Database Wizard . iiiil.. 36
Database Wizard: Starting . iiil.. 37
Database Wizard: Selecting the Database File ... ... ... ... . ... ... .. .._.............. 38
Database Wizard: Field Usage ... .. 39
Database Wizard: Select Fields ... . ... 40
Database Wizard: Field connections to variables ... ... ... .. . .. .. ... ... 41
Database Wizard: Additional Objects .. . ... 41




Database Wizard: Completing the Process ... ... 42

Using Filters ... i 42
Working with Variables ... ... 43
Editing Variables . 43
Internal Variables ... . 43
Types of Variables . 43
Defining Actions ... . 44
TWAIN Advanced ... . L 44
Actions Editor .. 45
Advanced Options for Label Quantity ... 46
Advanced Options for Load Variable Data ... . . ... 46
Advanced Options for Save Variable Data ... ... .. ... .. ... ... 46
Browse for File or Folder ... . 46
Close Label . L 47
Define Printer Settings .. . .. 47
Execute Script .. . 47
Execute SQL Statement .. .. 47
Filter Editor ... . L 49
For Every Label .. . 49
For Every Recordina Table ... . ... . . . ... 49
FOr 00D il 49
Import Data Into Database ... .. . .. ... 50
Load Variable Data .. .. 50
Move Focus to Object ... . 51
Open Document/Program ... ... 51
Open Label .. L 52
Open Another Form .. . il 52
Other ACtionS ... .. . il 52
Print Label . . 52
QU 53
Read Data from Serial Port . ... 53
Refresh Previews . . . 54
Refresh Database ... . L 54
Run Command File ... . il 54
Save Variable Data ... i 54
Seripting Languages ... .. ... . 55
Select Variables . 55
Send Custom Commands ... . ... 55
Send Data to TCP/IP . 56
Set Printer L 56
Set Variable . . 56
Translate Form ... i 57
Acquire Image ... 57
Verify License ... .. i 57
View Log File . il 57
Write Data to Serial Port . .. 58
Automatic Repositioning of Objects in the Resized Form ... ... .._._............. 58
Changing the Size of Multiple Objects Simultaneously ... 58
Importing Variables from the Label ... .. 59
Linking Object with Variables ... .. 59
Printing a Label Which File Name is Read from the Database ... .. 60
Printing Two or More Different Labels ... ... 61
Quickly Designing and Testing the Form ... .. 61
Changing the Focus of the Objects ... . . ... 61
Changing the Screen Position of the Running Form ... 62




Changing Object Visibility ... ... 63

Setting the Tab Order in Which the Data is Entered ... ... . ... ... ... 64
Translating Forms ... 65
Using Data from Database ... ... 67
Using Distributed Printing ... . 67
Automating the Software . .. 68
Command Line Parameters ... . ... . il 68
Technical SUPPOIt 69
Online SUPPOTt . 69




Introduction

About this manual

Your User Manual is composed of four main sections:
Introduction: This chapter will introduce you to the software.
Setting Up the Application: Learn how to set up and customize software to your preferences.

Designing Forms: Learn how to create forms. You should refer to this chapter regularly while
designing forms, until you have completely familiarized yourself with the commands. By using the
information contained in this chapter, you will be very quickly able to use the software efficiently.

Conventions used in this Manual

Text that appears in bold letters refers to the names of the menus, buttons and other 'clickable’'
things like OK button.

Text that appears in italic refers to the options and confirming actions - like Read only.
Text enclosed in brackets refers to keys from the PC keyboard like <Enter>.

Variables are enclosed in square brackets like [variable].

Welcome to NiceForm

NiceForm is a software package that helps you create forms for entering data and printing labels.
Using NiceForm you can easily design any form with none programming skills required.

The basic idea of the NiceForm is to simplify entering variable data on the labels. First you have to
design the label in NiceLabel using the variables of prompted or database type for the variable
fields on the label. Then you can use the NiceForm to create the simple user interface to fill in the
variable data needed to print a label. This way the user cannot accidentally modify the label, and
entering the data is greatly simplified. The process of printing labels is still performed by NiceLa-
bel, although the user sees only the form.

The way of designing forms is very user friendly and flexible. Forms can include different fixed
(text, pictures) or variable objects (edit fields, memo fields) and action buttons, which are used to
start some sort of action (e.g. print, or change the form).

The forms have two modes: the design mode and the run mode. In design mode you can create and
design forms and in the run mode you can enter data and print labels.

NiceForm has the logic that supports default values. This logic speeds up the work and prevents
printing labels with incorrect contents.




Setting up the Application

User Interface

Basic and Advanced User Interface

The software has two-level user interface. By default, basic user interface is enabled that makes
the software easier to use for beginners and inexperienced users.

To switch to the Advanced mode showing all program functionality, click on the Advanced button
in the bottom of some dialog boxes.

For example: The dialog box Actions Editor has two-level user interface.

Keyboard Shortcuts

Delete Deletes selected object

Shift + Delete Cut

Ctrl + Insert Copy

Shift + Insert Paste

Alt + Back-

e Undo

Alt + Shift +

Backspace Redo

Ctrl+ A Select all objects in the form

Ctrl + X Cut

Ctrl+C Copy

Ctrl+V Paste

Ctrl + Z Undo

Ctrl + N New

Ctrl+ O Open

Ctrl +S Save

Ctrl + F9 Run form

Ctrl+ G Snap to grid

Ctrl + Tab Leave the database table (change focus)

Alt + F4 Exit

Ctrl + move

object with Parallel moving of the object by main axes only
mouse

Ctrl + cursor Fine tuning the position of the object, move it in very
keys small steps

Shift + cursor Fine tuning the dimensions of the object, resize width
keys and height in very small steps

Turning mouse

wheel Scrolls the form up and down




Shift + turning
mouse wheel
Enter (or F2)
with any label Open dialog box with element's properties
element

Status bar

Status bar shows information and messages at the bottom of the window that helps you use the
application.

Scrolls the form left and right

Status bar information:

Indicates whether the form has been modified since the

Modified last time the file was saved (blank if the file has not been
modified).
Current pos- Current position of the mouse cursor. The start of the
ition coordinate system is the upper left corner of the form.
Label file- Label file attached to the form (blank if the label file is not
name attached).
Toolbars

There are several toolbars available in the application. You can hide/show them by choosing the
corresponding command in the View menu.

They are fully movable and can be placed anywhere on the screen. They can be docked within the
main window or floating outside the main window.

Form Security

Locking Form

In majority of cases you do not want the end-user to be able to modify forms. Once the form is
locked, all the actions (button actions, On Load, On Close, On Timer) will be encrypted.

One method to prevent the users having access to the design mode is running the form by double-
clicking on its shortcut. This will start the form directly in the Run mode, where no changes can be
done. But the user can bypass it by manually opening the form file.

To lock the form, do the following:

Open your form.

Select the command Form Properties in the File menu.

Go to the Advanced tab.

Tick the option Form locked.

Tick the option Password protection and click on the Set password button.
Provide the password and click on the OK button.

Click on the OK button.

NS kWD




8. Select the command Save in the File menu.
9. Close the form.
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Designing Forms

Using Toolbars

Using Database Toolbar
: Identity SRR AENEN

First field shows the list of currently active databases. It allows you to browse through the attached
databases.

[1dertity -] List box lists the links to the databases that are available in the
label.
Define a link to new database using Database wizard. The Data-

base wizard will guide you through the necessary steps to link data-
base on the label. The result will be database fields available as
variables.

Define new link to the database manually.

] []

Edit the properties of the selected link to the database. You can
change the database driver, select which records will be printed
and define if quantity of the labels comes from the database.

Delete the selected link to the database.

Note: Make sure that database fields are not used anywhere on the
label, linked to objects or used in the functions. Otherwise the link
cannot be removed. If you are not sure, where the database fields
are used, use the Label Inspector to find that out.

[&]

Click on this button to open the database table in database man-
agement application.

=

Using Standard Toolbar
Click on the icons in the standard toolbar will execute the following actions:
Create new form.
Create new form using the wizard.
Open existing form.
Save currently opened label.

Cut the selected objects to clipboard.

Ol [Z] 3 =] E

Copy the selected objects to clipboard.
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Paste the objects from the clipboard.
Undo last action.
Redo last action.

-_CIE'J Run Run the current form. New window with running form will open.

- Access to variables. Click on the small arrow for more commands.

ENEIENEE
gl
=
e
é;
EEREN

4| Databases Access to the databases. Click on the small arrow for more com-
mands.

Using Text Toolbar

You can use text toolbar to quickly format the text objects on the label.

: T Arial - 10 '@ﬁ

Here is how:

1. First select it the text object by clicking it.

2. Click the appropriate shortcut button in the text toolbar.

3. To change the font, select the appropriate font from the list in the list box.
4

. To change the size of the text, click on the list with font sizes and select appropriate size.

Note: You can change the fonts size also directly on the label by resizing the text element with a
mouse.

5. To format the text bold, italic or underline, click on the appropriate formatting buttons.
Formats the selected text in bold style.
Formats the selected text in italic style.

Formats the selected text in underline
style.

HiERE

Using Toolbox
To use the toolbox, do the following:
1. Click on the icon in the toolbox to select the object.

2. Move the mouse over the form. See how the cursors has changed.
3. Click on the form where you want to place the selected object.
Some objects have additional shortcut on the right side of the icon. Using this shortcut you can

quickly create a new object with fixed content, create a new variable and connect it to the selected
object or connect the object to one already defined variable.
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Using Transformations Toolbar
-Black o 32 align = @ E‘a‘b B

Use the tranformations toolbar to modify the color, position or arrangement of the objects.

Note: The objects are always aligned to the first selected object.

(I =k |- -] Choose the color for the selected object on the form.

Align the objects to each other or to the form.

Click on the small arrow button for more options.

Position selected object on the top of all other objects.
Pu Position selected object on the bottom of all other
objects.

Note: If you dock the toolbar on the left or the right side of the window, all alignment icons
become available.

Align to left.

Align to horizontal center.
Align to right.

Align to top.

Align to vertical center.
Align to bottom.

Distribute selected objects hori-
zontally.

Distribute selected objects vertically.

iE (2] [B] (5] [8] (L] [o2] []

Note: If you hold <CTRL> key while clicking on the align buttons, the objects are aligned rel-
ative to the form instead to each other.

Using Variable Toolbar
P 3 Quantity P % W g

The list box contains the variables available on the form. If you have selected some variable
object, the list box displays variable linked to that object. If no object is selected, selecting a vari-
able then clicking on the form places new text object and links it to the variable.

Create new variable manually.
Edit the properties of the selected variable.

Note: If you select the variable object, the variable linked to the object will be
automatically listed in the list.

Delete the selected variable.
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Note: If you want to delete the variable, you must not use it on the form
linked to label objects.

@ Open the variable dialog box.

Obtain variables from the label file.

There are several methods to connect a variable to some form objects that should contain variable
values.

If you have the object already positioned on the form, select it, then choose the appro-
priate variable in the list.

If the object is not already on the form, you can first select the variable in the list and then
click the form where you want the element positioned. Text element will appear there
and will be connected to the chosen variable.

If you want any other object (and not text) connected to the variable, you can first select
the variable in the list, then click the desired element in the Toolbox and then click on the
form.

You can click on the small arrow button next to the object icon in the toolbox, select the
option Use Existing Variable, select the variable from the list and click on the form.

Variable toolbar always shows the name of the variable, which is attached to the currently selec-
ted object. If there are two or more elements selected and do not have the same variable attached
to it, then the variable combo box is empty.

Working with Objects
Working with Buttons

Defining Actions

Browse for File or Folder

The action opens a file browser window. The action settings offer details which enable easier con-
textual file or folder browsing, such as a pre-defined extension filter and starting directory.

Note: If the checkbox is marked to indicate that the name of the selected file will be saved as a
variable, see the appropriate sections of Help to learn more about variables.

Filter: Define the file browsing filters. You may choose between preset filter choices or enter
your own.

Initial Directory: Choose which folder will be open by default in the browsing window.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Close Label

Use this command to force closing the label that you previously opened with a command Open
Label.
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Do not use this action if printing speed is important to you. By default, NiceForm will open the
label and keep it open as long the application runs. Keeping the label open saves you time you
would otherwise spend for re-loading the label. In time-critical label-printing environments every
second can count.

Note: NiceFormwill not see the changes in the label file that label designer made and will con-
tinue to print the older label contents. If the design of your label templates changes frequently,
make sure to use the action Close Label, otherwise don't use it to speed up printing.

Define Printer Settings

The action displays the dialog box with properties of the form's selected printer.

This way the end user can change the printer properties like printing speed, darkness, and other
controls independently from the current printer settings in the label, in the printer driver or printer
hardware settings. The modifications the user makes are temporarily and influence current print
job only. The modifications are not saved in the label or form.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Execute Script

This action defines the programming script that you can use for advanced data manipulation on the
form. The scripting allows you to implement some feature that is not built-in the application and
expand the possibilities in your forms.

Several scripting languages are supported on the form, but only one at a time. To choose between
scripting languages see the options in File -> Form Properties -> Scripting.

Define Script: Type in your script in the text area.

Build Script: Click on this button to open the Expression Editor that will help you construct your
script. The button might not be available for all scripting languages.

Check Script: Click on this button to verify the syntax of you script. If there is a syntax error in
the your script, you will be notified about it.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to execute the current action Execute script only when the condition is True.

Execute SQL Statement

Here you can define a custom SQL statement that can add, modify, or delete data in the database
table.

When running forms on desktop platform you can use the SQL commands SELECT, INSERT,
UPDATE and DELETE. When running forms on the web platform you can use all
SQL commands.

This procedure is considered advanced and requires prior SQL programming knowledge.

SQL Statement: Type in the SQL commands to execute with this action. TO use form's variables
in the SQL statement, put a colon (:) in front of their name. If the form variable includes a space,
enclose the variable in square brackets [].

For example: The user works with his customer database. The table Customers includes a field
named Customer ID. There is a variable /D defined in a form. The user enters the value for /D
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using an edit field and wants to delete all customer information for the entered /D. The
SQL statement will delete all records where the value of the Customer ID field is equal to the
entered /D number (Customer ID = ID).

You must use the variable /D in your SQL statement. In NiceLabel software you can do it by
including colon character (:) in front of the variable name, like this:

DELETE FROM Customers WHERE Customer ID = :[ID]
To test your SQL statement, click the Execute button.

The result of your SQL statement is remembered in the variable you select in the Variable section.

o When you use commands INSERT, UPDATE or DELETE the variable will contain the
numerical value, which represents the number of the rows affected by the command.
You can use this result for execution tracking. If the result is 0, no updates were done in
the database.

e When you use command SELECT the variable will contain the result returned from the
database server.

The result for SELECT command can be:

o Value of a single field: in this case your SQL statement is written to return just single
field from one record field.
Sample statement:

SELECT MyField FROM dbTable WHERE ID = 1

Result: If there is just one record matching the above condition, the value of variable
will be value of field MyField.

o Values of two or more fields, in one or more records: In this case a dataset is
returned. Each line in the dataset contains data from one record, fields are included in the
line, delimited by comma (,). The first line will contain names of the fields. You will
have to write a script to parse the values into individual values, if you want to use indi-
vidual fields in the form.

Sample statement:

SELECT * FROM dbTable WHERE ID = 1 OR ID = 2

The result:

HID "’HMyFieldH
n IYV’VIﬁellel
H2"’Hﬁeld21l

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

For Every Label

The property defines the list of labels for which all defined actions will be executed.

Fixed values: Define the list of labels.
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o Add: Add labels to the list.

o Arrow next to the Add button: Add variables to the list. The variables must contain
the path and name of the label.

o Delete: Remove the selected item from the list.
o Arrow buttons: Change the order of labels in the list. This is the order in which the
labels are printed.
Variable value: Select one variable that will contain the path and name of the label.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

For Every Record in a Table

The property defines the table. All records or all selected records from the table will be used in the
defined actions.

Table: Select the name of the table you want to use.

Use selected records only: Enable this option to use only selected records in the defined actions,
not all records in the table.

Note: The database table must already be defined on the form.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

For Loop

For loop makes it possible for the action to be executed a certain number of times.
Loop from: Select a starting value for the incremented loop.

Loop to: Select an end value for the incremented loop.

Note: If the loop from value is higher than the loop to value, the loop will decrement the value
regressively.

The Loop from and Loop to values can be fixed or variable, and the current loop value can also
be saved into a variable.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Import Data Into Database

Note: The action is only available for forms running on the Web platform, not for forms running
on a desktop platform.

This action will read data from formatted CSV text file and import it into the SQL database.

Before you can use this action, you must have already created a connection to the SQL database.
The action does not work with file-based databases, such as Microsoft Access, or data files like
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Microsoft Excel, or plain text files. You must use server-based SQL database, such as Microsoft
SQL Server.

Rules:

e You must have the table already created within SQL database

o The table must contain PRIMARY KEY

o The first line in a text file must define field names

o The field names in the text file must match field names in the database table

« If the text file does not provide a value for some field, NULL will be written to the data-
base. If the field does not accept NULL values, then the empty string ("") will be written.

« Setting values for auto-incremental fields are ignored. The database will provide value
for such field.

o Ifthe value from text file does not match the structure of the field, the action is canceled
and error message displayed. E.g. when you try to write alphanumerical value into
numerical field.

« Ifyou filter records in the form and display just records matching some condition, you
can only import records that either do not provide value for the filter field, or provide the
same value for the filter as your form has defined.

Y ou can only use filters with "equal" condition, not "greater than", "less than", "con-
tains" or similar.

« If'the text file contains fields not defined in the SQL database, the import will ignore
them. Only known fields will be imported.

Condition: This is a scripting Boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Load Variable Data

This action reads the data from the text file and sets values to the variables on the form.
File Name: Specify the name of the text file with data. It can be fixed or variable.

Advanced Options: Click on this button to select variables you want to load from the text file and
define the structure of the text file.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Move Focus to Object

This action moves the focus to a particular object on the label. When some object has the focus, it
is active and you can use it without selecting it with the mouse first. Normally, the focus is moved
from one object to another with press of a tabulator (Tab) key on the keyboard. The tab order is
defined during the form design process.

If you do not change the tab order, the default tab order is the order in which you put the objects on
the form.
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Note: To see the tab order, select Design -> Tab Order.

However, you can also use this action to put the focus on some form object. Whenever the action
executes, the selected object will have the focus.

Move focus to first object in tab order: When the action executes, the first object in the tab
order will have the focus.

Move focus to the selected object: When the action executes, the selected object will have the
focus.

Note: You can define the object names that you see in the combo box. Each object has an unique
name in the Advanced tab of its properties.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Open Another Form

This action will close the current form and open the specified form.

File Name: Select a fixed form name on the hard disk or select a variable containing the name of
the form.

Previously opened form: The form that was used to open the current form will be re-opened. The
history of opened forms is remembered, and you can go back several levels deep.

Note: The result of using the Previously opened form option is the same as if you would click
Back button in your Internet Explorer while browsing the internet.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Open Document/Program

The action executes the specified program or opens the specified document, when the button is
clicked.

File Name: Define a file name for the document/program that you want to open. Include full path
to the program or document.

Note: If you are opening a program, you can also include variables as parameters in the com-
mand line. Enclose the variables in the square brackets. For example: c:\program files\my pro-
gram.exe [Variable]

Hide window: Enable this option to hide the Command Prompt window that displays when the
selected application launches. Usually you do not want the user to see the black Command Prompt
window.

Wait for completion: Enable this option if you want to wait for the result from the application that
you run and the next actions in the list rely on its completion.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.
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Open Label

This action defines the label file that will be used to printing, when the user clicks on the button.

Label: Define the fixed name of the label or select the variable containing the path and name to
the label.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Note: The action Open Label can contain other actions nested below it. You must always use the
Open Label action to print labels and executing some other actions. Such actions cannot exist on
their own, but are always nested below Open Label action.

Print Label

This action executes the printing command and defines how many labels will be printed.

Number of Labels: Define how many labels should be printed.

o Fixed: The number entered in the edit field defines how many labels will be printed.

o Unlimited: The maximum quantity of labels supported by the current printer will be prin-
ted. This options is generally used with database files, where unlimited would be used as:
print the whole database.

Note: Be careful and do not create an infinite loop, when label printing would not end.

« Variable quantity: Some variable on the label will set the quantity of labels to be prin-
ted. In most cases this will be some field from the database. The form does not know
how many labels will be printed. When the data is processed on the label, the variable
quantity gets its value.

o From variable: The value of the selected variable defines the quantity of labels that will
be printed.

Advanced Options: Click this button to set advanced options for the quantity of labels.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Read Data from Serial Port

Define how the data will be read from the serial port.

The data received on the serial port is stored in the generated variable. You can use the value of
the variable directly on the label or use it in some other action in the form (like Visual Basic script
if additional data-manipulation is required).

Serial Port Settings: Define the properties of the serial port where you have attached the serial
device. The parameters in this dialog box have to match the settings on the device. Refer to the
documentation of your serial communication device so you will be able to specify the correct com-
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munication parameters. If the settings on the device and in the software do not match, com-
munication will not be possible.

Initialization Data: Initialization data is set of characters that need to be sent to the serial device in
order to activate it and make it ready to send data to the PC computer. Type in the set of characters
that must be sent to the device. Click on the small arrow button on the right to display list of all avail-
able special characters.

Send initialization data: Tick the option to enable initialization data. This is optional feature.

Wait before starting to read data: You can define the time-out in milliseconds after which
the receiving data will begin. This is optional feature.

Filter: You can filter the data you receive from the serial port and cut only the important characters.
You can limit what data you will receive. This is optional feature.

Use start and stop string: Define the two strings that will enclose the data you need to
extract. For example, if start string is ### and stop string is $$9, the extracted data from the
raw data q###123458$9$1 is 12345.

Use start and end position: Define the start and stop position of characters you want to
extract. For example, if start position is 10 and stop position is 14, the extracted data from the
raw data q###12345$$81 is 12345.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started only
if condition returns True as the result of the expression.

Refresh Database
The action refreshes a database object on the form. There must be a database object on the form
for this action to be available.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Refresh Previews

The action refreshes all label preview objects on the form.

By default each label preview updates itself automatically as soon as the data it previews changes.
In some cases --especially when a lot of variables and database fields are used on the label-- the
label preview might be slowing down the user experience. A solution is to disable automatic
refresh of the label preview. When you want to update the previews, use this action.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Run Command File

Executes the commands in the specified command file. The following types of the command files
are supported:

o JOB file
o XML file
e CSV (Comma Separated Values) file
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All of the command files provide the commands to instruct the print engine what to do. In most
cases you want to open the label, set the values to variables on the label and print the label to the
specified printer.

See the chapters in the section Integration and Connectivity in the label designer user guide or
Automating the Software in middleware integration module user guide.

File Name: You can set a fixed command file name or let some variable define it.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Save Variable Data

This action saves the data from the variables to the text file.
File Name: Specify the name of the text file with data. It can be fixed or variable.

Advanced Options: Click on this button to select variables you want to save from the text file and
define the structure of the text file.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Select Variables

Select the variables which values you want to save/load to/from file. Use Up and Down arrows to
set the order of appearance in which values are defined in the text file.

Send Custom Commands

Send the defined list of commands to the print engine for execution.
Commands: Enter the commands in the text area.

Edit: Click on the Edit button to open the Expression Editor that will help you define the script of
custom commands.

You can also include variables in the commands. Just type in the variable name and enclose it with
the square brackets.

For example: To print the number of labels as specified in the variable Quantity, the print com-
mand should look like PRINT [Quantity]

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Note: For more information about commands refer to the help or user guide.

Send Data to TCP/IP

Define the sending of data to the TCP/IP port.
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Destination: Define the destination to which you wish to send the TCP/IP data. If you only provide
the address and not the port number, the port will default to 80. Click on the detailed settings button
to enter the host name or port number separately, or to connect them with a variable.

Content: Set the data to be sent to the TCP/IP port.
Encoding: Set the encoding data

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started only
if condition returns True as the result of the expression.

Set Printer

The action defines the printer name that you want to use for label printing. This setting will over-
ride the printer setting that were set directly on the label.

Note: This action is useful, if you want to print one label file to several different printers without
the need for creating duplicated label files linked to different printers.

Printers: Define fixed name of the printer or select the variable name containing the name of the

printer.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Set Variable

The actions sets the defined value to the selected variable.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

View Log File

This action opens the printing log file for the current workstation. As such, the button with this
action offers access to the reprinting function, where past print jobs can be selected in the log file
and reprinted.

Reprinting:
1. Define how many labels should be printed

2. Select the printer for the reprinting
3. Select the individual labels for reprinting in the list.

Note: If many labels are listed, you can use the search function to locate the label that you wish
to reprint.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.
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Verify License
This action allows the user to insert a license check to the trigger.
o If'the entered Solution ID number is not the same as the ID of the application, no actions

will be executed.

« Ifthe entered value is 0, actions will be executed if any valid license is found.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Write Data to Serial Port

Define how the data will be written to the serial port.

The data sent to the serial port is stored as a fixed value or in the generated variable. You can use
the value of the variable directly on the label or use it in some other action in the form (like Visual
Basic script if additional data-manipulation is required).

Serial Port Settings: Define the properties of the serial port where you have attached the serial
device. The parameters in this dialog box have to match the settings on the device. Refer to the
documentation of your serial communication device so you will be able to specify the correct com-
munication parameters. If the settings on the device and in the software do not match, com-
munication will not be possible.

Data: Set the data to be sent to the serial port as fixed data or data from a variable. Type in the set
of characters that must be sent to the device. Click on the small arrow button on the right to display
list of all available special characters.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started only
if condition returns True as the result of the expression.

Quit
The action will close the currently running form.

If you are a form designer, executing Quit action will close the running form and return you back
to the form designer.

When the print operator (the end user) will execute Quit command, the form will close entirely.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Creating the Button

To use the button object, do the following:

1. Click on the | o (1D icon in the toolbox.

Note: You can also select the command Button in the Object menu.

2. Click on the form, where you want to position the object.
The dialog box opens with object properties.
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Go to the Actions tab.
Click on the Edit button to open the Actions Editor window.

Define the actions you want to execute when the user will click on the button.
Drag the appropriate actions from the list on the left side to the right working area.
Set the action properties, if necessary.

6. When ready, click on the OK button to close the Actions Editor.
7. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.

Working with Button Group

Creating the Button Group

To use the button group object, do the following:

1.

Click on the Button Group icon in the toolbox or select the command Button Group
object in the Object menu.

Click on the form, where you want to position the object. The dialog box opens with
object properties.

Go to the Actions tab.

Click on the Edit button to open the Actions Editor window.

5. Define the actions you want to execute when the user will click on buttons. Drag the

appropriate actions from the list on the left side to the right working area. Set the action
properties, if necessary.

6. When ready, click on the OK button to close the Actions Editor.
7. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.

Working with Check Boxes

Creating the Check Box

To use the check box object, do the following:

1.

Click on the | Check Box |'| icon in the toolbox.

Note: You can also select the command Check box in the Object menu.

2.

Click on the form, where you want to position the object.

3. Double click on the object.

The dialog box opens with object properties.
Go to the Contents tab.
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5. Select the variable from the list that will store the value for check box state (enabled/dis-
abled).

Note: If no variable is available in the list, import the variables from the label (Design -> Get
Variables) or click on the button New.

7. Go to Values tab.

8. Type in the text for the check box. The text will explain to the user what he can
enable/disable with the check box.

9. Enter the values for both states of the check box (enabled and disabled).
10. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.

Working with Combo Boxes

Working with Combo Box

To use the combo box object, do the following:

1. Click on the |':E' Combo Boix | | icon in the toolbox.

Note: You can also select the command Combo box in the Object menu.

2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.

4. Go to the Contents tab.
5. Select Variable value for the contents.

6. Select the variable from the list. This variable will store the value the user will select.

Note: If no variable is available in the list, import the variables from the label (Design -> Get
Variables) or click on the button New.

7. Go to Values tab.

8. Click on the Edit button.
The Edit items dialog box opens.

9. Enter the values that will be available for the selection. Each line contains one value.
10. Click on the OK button to close Edit items dialog box.

11. You can use the Up and Down arrows to change the order of appearance of your pre-
defined values.

Note: You can also use keyboard shortcuts Alt + Up and Alt + Down to change the position of
values in the list.

12. Click on the OK button.
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Note: To cancel placing an object on the form, press the ESC button.

Working with Database Navigator

Creating the Database Navigator

To use the database navigator object, do the following:

1. Click on the |l&' Database Navigator | | icon in the toolbox.

Note: You can also select the command Database Navigator in the Object menu.

2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.

4. Go to the Database tab.
5. Select the database from the list.

Note: If no database is available in the list, click on the Edit button and create a link to the data-
base.

6. Click on the OK button.

Working with the Database Navigator

The database navigator is used to move the focus from one record in the database to the next.

All objects that are connected with the fields from the same database that database navigator is
linked to will change, when you use the database navigator.

Note: The database navigator is also part of the table object. You would use it as a separate
object, if you do not use the table object on the form.

The available buttons in the database navigator are:

I

First
record

Prior
record

Next
record

Last
record

Refresh
data

R

>

L3
o
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Working with Database Search

Creating the Database Search

To use the database search object, do the following:

. N .
1. Click on the | e e | | icon in the toolbox.

Note: You can also select the command Database Search in the Object menu.

2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.

4. Go to the Database tab.
5. Select the database from the list.

Note: If no database is available in the list, click on the Edit button and create a link to the data-
base.

6. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.

Searching for an entry in the database will also select the corresponding database record in Edit
fields with an enabled lookup setting, if they are connected to the same database.

Working with the Database Search

The database search is used to search for the records in the database. Only records complying with
the condition are obtained from the database.

Note: The database search is also part of the table object. You would use it as a separate object,
if you do not use the table object on the form.

The available buttons in the database search are:

Mary Edit box for entering the data database search must find in the
database.
Click on this button to perform the search.
3 Select the field from the database, where the search will be
conducted.

Enable filter functionality. You can add advanced filters to the
database.

Working with Edit Fields
Creating the Edit Field

1=

To use the edit field object, do the following:
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1. Click on the [= Edit Field | | icon in the toolbox.

Note: You can also select the command Edit field in the Object menu.

2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.

4. Go to the Contents tab.
5. Select Variable value for the contents.
6. Select the variable from the list. This variable will store the value the user will provide.

Note: If no variable is available in the list, import the variables from the label (Design -> Get
Variables) or click on the button New.

7. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.

Working with Frame Objects

Creating the Frame Object

To use the frame object, do the following:

1. Click on the | rErie | icon in the toolbox.

Note: You can also select the command Frame in the Object menu.

2. Click on the form, where you want to position the object.

3. Ifyou click once, the frame is inserted in a default size. You can click once and hold the
left mouse button, then drag in the desired direction to resize the frame.

Note: To change the object properties, double click on it. To cancel placing an object on the
form, press the ESC button.

Working with List Boxes

Creating the List Box

To use the list box object, do the following:

1. Click on the | ER List Box | | icon in the toolbox.

Note: You can also select the command List box in the Object menu.

2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.
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4. Go to the Contents tab.
5. Select Variable value for the contents.

6. Select the variable from the list. This variable will store the value the user will select.

Note: If no variable is available in the list, import the variables from the label (Design -> Get
Variables) or click on the button New.

7. Go to Values tab.

8. Click on the Edit button.
The Edit items dialog box opens.

9. Enter the values that will be available for the selection. Each line contains one value.
10. Click on the OK button to close Edit items dialog box.

11. You can use the Up and Down arrows to change the order of appearance of your pre-
defined values.

Note: You can also use keyboard shortcuts Alt + Up and Alt + Down to change the position of
values in the list.

12. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.

Working with Memo Fields
Creating the Memo Field

To use the memo field object, do the following:

1. Click on the | EE Mema Field H icon in the toolbox.

Note: You can also select the command Memo field in the Object menu.

1. Click on the form, where you want to position the object.

2. Double click on the object.
The dialog box opens with object properties.

3. Go to the Contents tab.
4. Select Variable value for the contents.

5. Select the variable from the list. This variable will store the value the user will provide.

Note: If no variable is available in the list, import the variables from the label (Design -> Get
Variables) or click on the button New.

6. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.
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Working with Pictures
Creating the Picture Object

To use the picture object, do the following:

1. Click on the |ﬁ EEIE | | icon in the toolbox.

Note: You can also select the command Picture in the Object menu.

2. Click on the form, where you want to position the object.
The Open dialog box opens.

3. Browse for the picture that you want to use.

4. Click on the Open button.

Note: To change the object properties, double click on it. To cancel placing an object on the
form, press the ESC button.

Working with Previews

Creating the Preview

To use the preview object, do the following:

1. Click on the | ) Preview | | icon in the toolbox.

Note: You can also select the command Preview in the Object menu.

2. Click on the form, where you want to position the object.
The dialog box Select Label File opens.

3. Browse to the label file you want to preview on the form.

4. Click on the Open button.

Note: To cancel placing an object on the form, press the ESC button.

Working with Radio Groups
Creating the Radio Group

To create the radio group object, do the following:

1. Click on the | ® Radio group | | icon in the toolbox.

Note: You can also select the command Radio Group in the Object menu.
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2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.

4. Go to the Contents tab.
5. Select Variable value for the contents.

6. Select the variable from the list. This variable will store the value the user will select.

Note: If no variable is available in the list, import the variables from the label (Design -> Get
Variables) or click on the button New.

7. Go to Values tab.

8. Click on the Edit button.
The Edit items dialog box opens.

9. Enter the values that will be available for the selection. Each line contains one value.
10. Click on the OK button to close Edit items dialog box.
11. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.

Working with Tables

Create the Table Element

To use the table object, do the following:

1. Click on the |E| Table H icon in the toolbox.

Note: You can also select the command Table in the Object menu.

2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.

4. Go to the Database tab.

5. Select a database from the list.
If no database is available in the list, click on the Edit button and define a link to the data-

base.
6. Go to the Columns tab.
7. Link each database field with the appropriate label or form variable.

Note: If no variable is available in the list, import the variables from the label before you can use
the table object.

&. Click on the OK button.

Note: To cancel placing an object on the form, press the ESC button.
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Formatting Table Object

To change the format of columns in the table, do the following:
1. Double click on the table object.

The dialog box opens with object properties.

Go to the Columns tab.

Select the database field you would like to format.

Click on the Display Style button.

A

Format the title and data area.
The title are is the caption of the field, the data area displays the records from the data-
base.

6. Click on the OK button to close Column Properties dialog box.
7. Click on the OK.

Linking Fields with Variables

To link database fields with appropriate variables in the table object, do the following:

1. Double click on the Table object.
The properties of the table object will open.
2. Go to Database tab.

3. Make sure the proper database is selected in the list.

Note: If no database is available in the list, click on the Edit button and define the link to the data-
base.

4. Go to the Columns tab.

5. Click on the <not connected> entry next to the database field and select the proper vari-
able from the list.

Note: If no variable is available in the list, attach a label to the form. During the attaching pro-
cess the form will import the label variables.

6. Repeat step 5 for all other database fields that need to be linked with the variables.
7. Click on the OK button.

Using Master - Detail Connection

Master - detail connection is the functionality available in the table element that allows you to link
two database tables together. The first table is master table. The second table is slave table that
displays only the records that comply with the selected record in the first database. One field in the
master table links to the field in the slave table. Only the records in the slave table that have the
same contents in that linked field as the master database are displayed.

The example:

Here is most likely usage of the Master Detail Connection functionality. There are three database
tables that contain information about customers, orders and items that you want to use on the form.
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Using Master Detail Connections allows you to construct linked tables which data changes accord-
ing to the selection in the parent table.

The table contains a list of all customers with the IDs of their

CUSTOMERS
orders.

ORDERS The table contains a list of all orders that the customers have
made. The orders contain the IDs of the items they include.
The table contains information about the items.

ITEMS

All three tables need to be positioned in the form. The first table form element has to be connected
to CUSTOMERS database table (this is done in the Database tab) and Master Detail Connection
is disabled on it.

The second table on the form is connected to ORDERS database table (this is done in the Data-
base tab). The table with Customers is the parent table for the Orders table. They will have to be
linked together. Connect the ORDER _ID field from the CUSTOMERS database with the
ORDER _ID field in the ORDERS database. This link will ensure that only the Orders for the cus-
tomer selected in the first table will be shown in the second one.

Then connect the third form table element to the ITEMS database table. The Orders table is a par-
ent for the Items table. They too will have to be linked together. This will ensure that only items
from the selected Order (from the second database) will be shown in this third database table.

The result of all this preparations is the following. The user selects the customer in the first table
(Customers), the second table (Orders) is automatically refreshed and displays only orders that the
selected customer has performed. When the user selects the appropriate order from the second
table, the third table (Items) is automatically refreshed and displays only the items the selected cus-
tomer has order in the selected order.

Working with Text Objects
Creating the Text Object

To use the text object, do the following:

1. Click on the |4*?‘Eti L0 | | icon in the toolbox.

Note: You can also select the command Text in the Object menu.

2. Click on the form, where you want to position the object.
The dialog box opens with object properties.

3. Enter the content for the object, then click on the OK button.

Note: To change the object properties, double click on it. To cancel placing an object on the
form, press the ESC button.

Working with Variable Prompts
Working with the Variable Prompt

To use the Variable Prompt object, do the following:
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1. Click on the | Variable Prompt H icon in the toolbox.

Note: You can also select the command Variable Prompt in the Object menu.

2. Click on the form, where you want to position the object.

3. Double click on the object.
The dialog box opens with object properties.

4. Go to the Content tab.
5. Select Variable from the Content pane.

6. Review the form variables or add new variables, and edit the length, default values, and
entry type limitations of current variables.

Your Variable Prompt object is set up and ready for use in the form.

Aligning Objects on the Form

1. Select all objects that you want to align.

Note: Press and hold <Shift> key while clicking on the objects to select more than one object.

2. Select the command Align from the Transformations menu.
The same align options are available in the Transformations toolbar.

Moving and Resizing Objects

You can move selected objects to another position by dragging them, or resize them, by selecting
object's handles and dragging them in the desired direction.

Selecting Objects

To select an object, simply click on it. To select more than one object, hold <Shift> while clicking.

You can also drag a rectangle around the objects to select all of them. The rectangle does not have
to enclose all of them, it is enough that it only touches the objects you want to select.

Using the keyboard to select objects

You can also use keyboard shortcuts to select move and resize objects.

Selects new object that is Up (down, left, right) from

Cursor keys the one already selected.

Ctrl + Cursor Moves the currently selected object in the direction of
keys the pressed cursor key.
ift +
Shift + Cursor Resizes the selected object.
Keys
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Working with Variable Data

Contents Providers

Contents Providers

Contents Provider is an expression for any method that can be used as an source of data for ele-
ments on the form. It is applicable to all form elements that can have some sort of data associated

with them.

The contents provider for objects can be one of the following:

Fixed

Variable

Database

When you select Fixed, you can enter a desired value in the edit box.
This value will remain the same for the object. To edit the text, all
standard Windows editing features (cut, copy, and paste) can be
used.

When the Variable option is selected, you can connect any variable
field to the element, just select the appropriate variable name from
the list. This approach will allow you to change the variable value on
the labels.

If no variable is defined on the label, you should first create one or
import them from the labels.

When this type of contents provider is selected, you can select the
database field and link it to the object. The data from the database
table will be used for the object.

Working with Databases

Database Wizard

Database Wizard

Database wizard lets you specify the source database for the table in an easy step by step pro-
cedure. Click the Wizard button in the Database Access Functions dialog box or click the Wizard

button in the Database Tool.

The Database Wizard offers you a quick and easy method to make database table available to the
form elements. When the Wizard is finished, it will leave you with ready-made connection. You
can further modify the table layout and properties or use it as-is. This is a great shortcut for design-
ing quick connectivity to data in database tables.
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Database Wizard: Starting

Database Wizard

Welcome to the Database Wizard

Thiz wizard helps you connect vour data from
a database to the variable fields on the label,
f'ou will complete the following tasks:

- Select the databage

- Select figlds in the database

- Connect fields with label variables

To continue, chick Mest,

Database Wizard: Starting

On the starting screen of Database Wizard you will learn what tasks will be completed. Wizard
will comfortable guide you through each required step. The result of the Wizard will be database
table connected on the form. The database fields will be linked to form objects.
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Database Wizard: Selecting the Database File

Database Wizard

Browsze for Databasze File
Select the file that containg pour data, Lo il

(%) Direct database access. [Fecommended option!]
(") Other databases (ODELC)

! Idestity |

Browsze for the table containing your data, “ou can read data from Paradox, dBasze,
M5 Access and M5 Excel files.

Cancel ] ’ ¢ Back ” Mewt =

Database Wizard: Selecting the database file

First you must select the database file, which has stored the appropriate data, you would like use.
Wizard can work with MS Access, dBase, Paradox, and MS Excel databases. If you have any
other type of database, you will have to make a manual connection to the database and you cannot
use the Wizard.

Select the database file and click on the Next button to continue with the Wizard.
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Database Wizard: Field Usage

Database Wizard

Field usage
Specity the Lzage of the selected fields from the database.

Defing haw you want the selected database figlds to be Lzed:

{3} | want a table objgct
()| want an edit field for each field in the database.

()1 willlink; the: database fields to the objects myself later.

| Cancel ‘ | ¢ Back || Mest > l

Database Wizard: Field usage
Select how the database fields should be used on the form.
I want a table: A table object is used on the form and linked to the database.

I want an edit field for each field in the database: Edit field objects are linked with each data-
base fields.

I will link the database fields to the objects myself later: The wizard will only make the link to
the database, but will not make the fields available on the form. You will have to link them to
objects yourself.
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Database Wizard: Select Fields

Database Wizard E|
Select Fields :

Select appropriate fields from the database.
Select table figlds you want to uze on the form,
Available table figlds Ordered selected fields
Fozitian | ; D I
| Room [ 1 |Mame
Ficture S—

Fr

&

| Cancel ‘ | ¢ Back | | Mewt > l ‘ Firich |

Database Wizard: Select fields

Select the database fields you want to use on the form. Use the arrow buttons for managing the
fields.

Available table fields: All fields defined in the database.
Selected fields: The fields to be used on the form.

Click the arrow buttons to select fields.

Move selected field to the right side and use it on the table.

Move all fields to the right side and use them on the table.

Move all fields back to the left side and do not use them on the
table.

Move selected field back to the left side and do not use it on the
table.

Fields on the right side can be ordered. The first in the list will be the leftmost in the table element,
the last in the list will be the rightmost in the table. Use up and down arrow buttons to change the
order of fields.
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Database Wizard: Field connections to variables

Database Wizard E|
Field Connections Eﬂ s
Connect table fields with variables. ny-=

Connect table fields fram database with vanables on the label. Field value wil be
transfered to label variable at print time.,

T ahle fields: YWarniahles:
Pashion | ' [J PICTURE '
Ficture | POSITION

@ Quantity

Y .
Mame -» NAME
Foom -» ROOM

| Cancel ‘ | ¢ Back || Mest | ‘ Firich |

Database Wizard: Field Connections

You have to make a connections between database fields and variables on the form. The purpose
of this connection is to let the application know to which variable it has to assign a value read from
the database table. If you are using the same variable's names as the names of the fields, the
application will make the connections automatically. Variables and fields with the same names
will be connected together. If the names are not the same, you will have to make connections your-
self.

To add the link, do the following:

1. Select the field name from the left pane and appropriate variable name from the right
panee.

2. Click on the Add button to make a connection.

Delete: Deletes the currently selected connection from the bottom list.
Clear: Clear all defined connections.

Click on the Next button to continue with the Wizard.
Database Wizard: Additional Objects

If you have specified that the Wizard should create a table element connected to the database, this
table will also contain a search control and database navigator. But if you have selected that you
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need an edit field for each database field, you have the option to select additional objects that can
be positioned on the form as well.

Search Control For more information refer to the topic Database Search.
Database Nav- For more information refer to the topic Database Nav-
igator igator.

Database Wizard: Completing the Process

Database Wizard

Completing the Database Wizard

“'ou have successhully completed the Database Wizarnd.

Surnmary of tasks completed:
- Selected database table
- Selected figlds in the table

- Established links between database fields and vaniables

To close this wizard, clck Finish,

| Cancel ‘ | ¢ Back |

Database Wizard: Completing the process

All information required by the Wizard have been entered. You can review the changes you have
made. If you are not satisfied with the settings, click Back to return to previous step of the Wizard.
Click Finish to close the Wizard and create a new table connectivity based on parameters you
entered.

Using Filters

If you add the filter in the DESIGN mode on the form, such filter is stored with the form and is
applied every time the form is run. The user cannot remove such filter. If the user adds some cus-
tom filter in RUN mode, such filter is not stored with the form. It is active only for as long as the
form is running. When the form is closed, the filter is discarded and is not applied at next form run.
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Working with Variables
Editing Variables

You can only edit internal variables on the form.

If variable is defined and acquired from label file, you cannot make any modifications. When you
want to change such variable, you will have to make modifications to the variable on the label.
When you will re-open the form file, the application will automatically update the variable set-
tings.

Internal Variables

Internal variables are filled automatically by the software and you do not have any influence on
them. They cannot be edited and modified, but only used on the form. Their value is updated for
every printed label.

Internal variables are represented with the & icon so they can be easily distinguished from the
other types of variables.

The list of available internal variables:

ComputerName Contains the information about the computer name of a
PC computer where labels are processed, as specified
from Windows system.

Date Contains the current system date.

DefaultPrinterName Contains the name of the default printer on the system.

FormName Contains the name of the form file that is currently used.

LabelName Contains full name of the current label, including the
path to the file.

LabelPrinterName Contains the name of the printer that is used on the
label.

ShortFormName Contains the name of the form file without the path.
Only filename with the extension OFF is available.

ShortLabelName Contains the name of the label without the path. Only file-
name with the extension LBL is available.

SystemUserName Contains the name of the system Windows user that is
logged in and is running the application.

Time Contains the current system time.

UserName Contains the name of the Label Gallery user that is

logged in and is using the application. This variable has
some value only when you have enabled user man-
agement in the software.

Types of Variables

Each type of variable has its own icon to easier distinguish variables among each other. The icon
in front of the variable name determines its type.

The available types of variables are:

@ Prompt variables that are defined in a label file.
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The application reads these variables from the label file and show them in the

list.

4 Database variables that are defined in a label file.
The application will read these variables from the label file and show them in
the list.

& Local variables on the form.

These variables are local to the form and are not included in the label file. You
can use these variables on the form and in the actions.

e Internal variables on the form.
These variables are local to the form and are not included in the label file. You
can use these variables on the form and in the actions. Internal variables cannot
be modified, you can only use them.

Defining_Actions
TWAIN Advanced

Device dialog visible: Select this option if you wish to display the device driver settings dialog
before capturing the image.

Image settings: Set the color and the resolution for the captured image

Selection area: Select this option to limit the capture area of the image.

Note: Depending on the TWAIN device that you are using, some of the options may not be
applicable or available.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.
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Actions Editor

% Actions Editor

ﬁ“Eroperties Xgelete |@ @ La') Q
il Action Dietails
= Labeling = Open label C:h. SLabels\SAMPLE LBL
@ Firit label 9 Set variable Wariable: "I0" Yalue: "123"
',}- Set printer ; % Set printer devery B4-05 RFID
' Open label (3 Frirt label Mumber of labels: 1
Cloze label
[ Dther
@,- Open some other form
© Qui
Description
Set printer,
Advanced »» I 0K I [ Cancel ] l Help ]

Actions editor
Use the Actions editor to define the actions on the button.

Action types: All available action types are listed in the left pane. Similar action types are
grouped together. Each action has a description displayed at the bottom of the left pane.

Note: To show also the advanced actions, click on the Advanced button at the bottom of the dia-
log box. To switch batch to the basic mode, click on the Basic button.

List of defined actions: The right pane displays the actions that are already defined for the button.

« Insert: Click on this button to insert currently selected action to the right pane.

Note: You can also drag & drop action from the left to the right pane.

o Properties: Click on this button to open the properties of the currently selected action in
the right pane. Double clicking the action also opens the properties.

o Delete: Click on this button to delete the selected action in the right pane.
o Arrow buttons: Click on the arrow buttons to change the order of the actions in the
right pane. Use the same arrows to change the nesting of actions.

Actions in the Actions Editor can be copied to the Clipboard and pasted into another or the same
Actions Editor. If Actions are pasted into another Actions Editor, all of the variables used in the
copied Actions must also be defined in the target Trigger.
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Advanced Options for Label Quantity

Number of Skipped Labels: This many labels will be skipped on the first page of labels. the
option is useful is some labels on the sheet have already been used and you would like to use the
rest of the labels on the same page.

Note: The option for skipping labels is applicable when printing labels to office printers. It is not
available when using thermal printers.

Identical Label Copies: The option sets the number of label copies you want to use with every
printed label.

Label Sets: The option instructs how many times the printing process should be repeated.

For example: If you set Number of Labels to Fixed 5 and Number of labels sets to 3 in the
Advanced Options, the printing of 5 labels will be repeated three times, resulting in 15 printed
labels.

Advanced Options for Load Variable Data

Advanced options for the text file containing the exported data are defined in this dialog box.

Variables: Select which variables you want to load from the text file.

o All variables: The default setting is to load all variables.

o Selected variables: Click on the Select button and select the variables you want to load.

Other: Define the delimiter and text qualifier as are used for the text file.

Advanced Options for Save Variable Data

Advanced options for the text file containing the exported data are defined in this dialog box.

Variables: Select which variables you want to save to the text file.

o All variables: The default setting is to save all variables.

¢ Selected variables: Click on the Select button and select the variables you want to load.

If File Exists: Define the action, if the file already exists.

Other: Define the delimiter and text qualifier as are used for the text file.

Browse for File or Folder

The action opens a file browser window. The action settings offer details which enable easier con-
textual file or folder browsing, such as a pre-defined extension filter and starting directory.

Note: If the checkbox is marked to indicate that the name of the selected file will be saved as a
variable, see the appropriate sections of Help to learn more about variables.

Filter: Define the file browsing filters. You may choose between preset filter choices or enter
your own.

Initial Directory: Choose which folder will be open by default in the browsing window.
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Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Close Label

Use this command to force closing the label that you previously opened with a command Open
Label.

Do not use this action if printing speed is important to you. By default, NiceForm will open the
label and keep it open as long the application runs. Keeping the label open saves you time you
would otherwise spend for re-loading the label. In time-critical label-printing environments every
second can count.

Note: NiceFormwill not see the changes in the label file that label designer made and will con-
tinue to print the older label contents. If the design of your label templates changes frequently,
make sure to use the action Close Label, otherwise don't use it to speed up printing.

Define Printer Settings

The action displays the dialog box with properties of the form's selected printer.

This way the end user can change the printer properties like printing speed, darkness, and other
controls independently from the current printer settings in the label, in the printer driver or printer
hardware settings. The modifications the user makes are temporarily and influence current print
job only. The modifications are not saved in the label or form.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Execute Script

This action defines the programming script that you can use for advanced data manipulation on the
form. The scripting allows you to implement some feature that is not built-in the application and
expand the possibilities in your forms.

Several scripting languages are supported on the form, but only one at a time. To choose between
scripting languages see the options in File -> Form Properties -> Scripting.

Define Script: Type in your script in the text area.

Build Script: Click on this button to open the Expression Editor that will help you construct your
script. The button might not be available for all scripting languages.

Check Script: Click on this button to verify the syntax of you script. If there is a syntax error in
the your script, you will be notified about it.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to execute the current action Execute script only when the condition is True.

Execute SQL Statement

Here you can define a custom SQL statement that can add, modify, or delete data in the database
table.
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When running forms on desktop platform you can use the SQL commands SELECT, INSERT,
UPDATE and DELETE. When running forms on the web platform you can use all
SQL commands.

This procedure is considered advanced and requires prior SQL programming knowledge.

SQL Statement: Type in the SQL commands to execute with this action. TO use form's variables
in the SQL statement, put a colon (:) in front of their name. If the form variable includes a space,
enclose the variable in square brackets [].

For example: The user works with his customer database. The table Customers includes a field
named Customer ID. There is a variable /D defined in a form. The user enters the value for /D
using an edit field and wants to delete all customer information for the entered /D. The

SQL statement will delete all records where the value of the Customer ID field is equal to the

entered /D number (Customer ID = ID).

You must use the variable /D in your SQL statement. In NiceLabel software you can do it by
including colon character (:) in front of the variable name, like this:

DELETE FROM Customers WHERE Customer ID = :[ID]
To test your SQL statement, click the Execute button.

The result of your SQL statement is remembered in the variable you select in the Variable section.

o When you use commands INSERT, UPDATE or DELETE the variable will contain the
numerical value, which represents the number of the rows affected by the command.
Y ou can use this result for execution tracking. If the result is 0, no updates were done in
the database.

o When you use command SELECT the variable will contain the result returned from the
database server.

The result for SELECT command can be:

o Value of a single field: in this case your SQL statement is written to return just single
field from one record field.
Sample statement:

SELECT MyField FROM dbTable WHERE ID = 1

Result: If there is just one record matching the above condition, the value of variable
will be value of field MyField.

o Values of two or more fields, in one or more records: In this case a dataset is
returned. Each line in the dataset contains data from one record, fields are included in the
line, delimited by comma (,). The first line will contain names of the fields. Y ou will
have to write a script to parse the values into individual values, if you want to use indi-
vidual fields in the form.

Sample statement:

SELECT * FROM dbTable WHERE ID = 1 OR ID = 2

The result:

HID "’HMyFieldH
" 1 "’Hﬁeldlﬂ
H2"’Hﬁeld2"
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Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Filter Editor

The filter editor offers file filter settings for the Browse for File action. You can select one of the
preset filters by clicking on Add or create your own filter.

For Every Label

The property defines the list of labels for which all defined actions will be executed.

Fixed values: Define the list of labels.

o Add: Add labels to the list.

o Arrow next to the Add button: Add variables to the list. The variables must contain
the path and name of the label.

o Delete: Remove the selected item from the list.
o Arrow buttons: Change the order of labels in the list. This is the order in which the
labels are printed.
Variable value: Select one variable that will contain the path and name of the label.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

For Every Record in a Table

The property defines the table. All records or all selected records from the table will be used in the
defined actions.

Table: Select the name of the table you want to use.

Use selected records only: Enable this option to use only selected records in the defined actions,
not all records in the table.

Note: The database table must already be defined on the form.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

For Loop

For loop makes it possible for the action to be executed a certain number of times.
Loop from: Select a starting value for the incremented loop.

Loop to: Select an end value for the incremented loop.

Note: If the loop from value is higher than the loop to value, the loop will decrement the value
regressively.
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The Loop from and Loop to values can be fixed or variable, and the current loop value can also
be saved into a variable.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Import Data Into Database

Note: The action is only available for forms running on the Web platform, not for forms running
on a desktop platform.

This action will read data from formatted CSV text file and import it into the SQL database.

Before you can use this action, you must have already created a connection to the SQL database.
The action does not work with file-based databases, such as Microsoft Access, or data files like

Microsoft Excel, or plain text files. You must use server-based SQL database, such as Microsoft
SQL Server.

Rules:

o You must have the table already created within SQL database

o The table must contain PRIMARY KEY

o The first line in a text file must define field names

o The field names in the text file must match field names in the database table

« If the text file does not provide a value for some field, NULL will be written to the data-
base. If the field does not accept NULL values, then the empty string ("") will be written.

« Setting values for auto-incremental fields are ignored. The database will provide value
for such field.

o Ifthe value from text file does not match the structure of the field, the action is canceled
and error message displayed. E.g. when you try to write alphanumerical value into
numerical field.

« Ifyou filter records in the form and display just records matching some condition, you
can only import records that either do not provide value for the filter field, or provide the
same value for the filter as your form has defined.

You can only use filters with "equal" condition, not "greater than", "less than", "con-
tains" or similar.

« If'the text file contains fields not defined in the SQL database, the import will ignore
them. Only known fields will be imported.

Condition: This is a scripting Boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Load Variable Data

This action reads the data from the text file and sets values to the variables on the form.

File Name: Specify the name of the text file with data. It can be fixed or variable.
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Advanced Options: Click on this button to select variables you want to load from the text file and
define the structure of the text file.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Move Focus to Object

This action moves the focus to a particular object on the label. When some object has the focus, it
is active and you can use it without selecting it with the mouse first. Normally, the focus is moved
from one object to another with press of a tabulator (Tab) key on the keyboard. The tab order is
defined during the form design process.

If you do not change the tab order, the default tab order is the order in which you put the objects on
the form.

Note: To see the tab order, select Design -> Tab Order.

However, you can also use this action to put the focus on some form object. Whenever the action
executes, the selected object will have the focus.

Move focus to first object in tab order: When the action executes, the first object in the tab
order will have the focus.

Move focus to the selected object: When the action executes, the selected object will have the
focus.

Note: You can define the object names that you see in the combo box. Each object has an unique
name in the Advanced tab of its properties.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Open Document/Program

The action executes the specified program or opens the specified document, when the button is
clicked.

File Name: Define a file name for the document/program that you want to open. Include full path
to the program or document.

Note: If you are opening a program, you can also include variables as parameters in the com-
mand line. Enclose the variables in the square brackets. For example: c:\program files\my pro-
gram.exe [Variable]

Hide window: Enable this option to hide the Command Prompt window that displays when the
selected application launches. Usually you do not want the user to see the black Command Prompt
window.

Wait for completion: Enable this option if you want to wait for the result from the application that
you run and the next actions in the list rely on its completion.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.
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Open Label

This action defines the label file that will be used to printing, when the user clicks on the button.

Label: Define the fixed name of the label or select the variable containing the path and name to
the label.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Note: The action Open Label can contain other actions nested below it. You must always use the
Open Label action to print labels and executing some other actions. Such actions cannot exist on
their own, but are always nested below Open Label action.

Open Another Form

This action will close the current form and open the specified form.

File Name: Seclect a fixed form name on the hard disk or select a variable containing the name of
the form.

Previously opened form: The form that was used to open the current form will be re-opened. The
history of opened forms is remembered, and you can go back several levels deep.

Note: The result of using the Previously opened form option is the same as if you would click
Back button in your Internet Explorer while browsing the internet.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Other Actions

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as th4e result of the expression.

Print Label

This action executes the printing command and defines how many labels will be printed.

Number of Labels: Define how many labels should be printed.

o Fixed: The number entered in the edit field defines how many labels will be printed.

e Unlimited: The maximum quantity of labels supported by the current printer will be prin-
ted. This options is generally used with database files, where unlimited would be used as:
print the whole database.

Note: Be careful and do not create an infinite loop, when label printing would not end.

o Variable quantity: Some variable on the label will set the quantity of labels to be prin-
ted. In most cases this will be some field from the database. The form does not know
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how many labels will be printed. When the data is processed on the label, the variable
quantity gets its value.

o From variable: The value of the selected variable defines the quantity of labels that will
be printed.

Advanced Options: Click this button to set advanced options for the quantity of labels.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Quit
The action will close the currently running form.

If you are a form designer, executing Quit action will close the running form and return you back
to the form designer.

When the print operator (the end user) will execute Quit command, the form will close entirely.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Read Data from Serial Port

Define how the data will be read from the serial port.

The data received on the serial port is stored in the generated variable. You can use the value of
the variable directly on the label or use it in some other action in the form (like Visual Basic script
if additional data-manipulation is required).

Serial Port Settings: Define the properties of the serial port where you have attached the serial
device. The parameters in this dialog box have to match the settings on the device. Refer to the
documentation of your serial communication device so you will be able to specify the correct com-
munication parameters. If the settings on the device and in the software do not match, com-
munication will not be possible.

Initialization Data: Initialization data is set of characters that need to be sent to the serial device in
order to activate it and make it ready to send data to the PC computer. Type in the set of characters
that must be sent to the device. Click on the small arrow button on the right to display list of all avail-
able special characters.

Send initialization data: Tick the option to enable initialization data. This is optional feature.

Wait before starting to read data: You can define the time-out in milliseconds after which
the receiving data will begin. This is optional feature.

Filter: You can filter the data you receive from the serial port and cut only the important characters.
You can limit what data you will receive. This is optional feature.

Use start and stop string: Define the two strings that will enclose the data you need to
extract. For example, if start string is ### and stop string is $$$, the extracted data from the
raw data q###12345%8881 is 12345.
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Use start and end position: Define the start and stop position of characters you want to
extract. For example, if start position is 10 and stop position is 14, the extracted data from the
raw data q##123458881 is 12345.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started only
if condition returns True as the result of the expression.

Refresh Previews

The action refreshes all label preview objects on the form.

By default each label preview updates itself automatically as soon as the data it previews changes.
In some cases --especially when a lot of variables and database fields are used on the label-- the
label preview might be slowing down the user experience. A solution is to disable automatic
refresh of the label preview. When you want to update the previews, use this action.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Refresh Database

The action refreshes a database object on the form. There must be a database object on the form
for this action to be available.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Run Command File

Executes the commands in the specified command file. The following types of the command files
are supported:

o JOB file
o XML file
e CSV (Comma Separated Values) file

All of the command files provide the commands to instruct the print engine what to do. In most
cases you want to open the label, set the values to variables on the label and print the label to the
specified printer.

See the chapters in the section Integration and Connectivity in the label designer user guide or
Automating the Software in middleware integration module user guide.

File Name: You can set a fixed command file name or let some variable define it.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Save Variable Data

This action saves the data from the variables to the text file.

File Name: Specify the name of the text file with data. It can be fixed or variable.
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Advanced Options: Click on this button to select variables you want to save from the text file and
define the structure of the text file.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Scripting Languages
NiceForm supports the following scripting/programming languages.
Visual Basic Scripting Edition (VBScript)

VBScript is scripting language developed my Microsoft that is modelled on Visual Basic. VBscript
has been installed by default in every desktop release of Microsoft Windows since Windows 98; in
Windows Server since Windows NT. NiceForm will use the VBScript already installed in the sys-
tem. To help you begin working with VB script, NiceForm ships with the help file named
Microsoft Windows Script Technologies that includes VBScript user's guide and VBScript lan-
guage reference. Additionally, look up Web programming resources, such as w3schools.com.

Python

Python is general-purpose high-level programming language. By default, NiceForm does not sup-
port Python. Before you can use Python programs, you must install Python libraries in your
PC. You can find Python installation files on the CD and also online.

You need Python version 2.x and the following components. Make sure the versions of both com-
ponents match. For example, both versions are 2.7.

o Python Windows Installer (from python.org)

o Python for Windows extensions (project pywin32 from sourceforge)

For Python user guides, documentation, samples and additional information visit the official Python
Web site.

You can use Python scripts in the forms running on the Web (when using product NiceLabel Power-
Forms Web), while VBScript is not supported on the Web.

Using Python in NiceLabel software has a bit different syntax when referring to variables. To set
or use variable value, you must add ".Value" to the right of the variable name; where the word
"Value" is case sensitive. For example, to set value abc to the variable varl, you must use the
syntax:

varl.Value="abc'

For more information about Python syntax in NiceLabel software, see the Knowledge Base article
KB204.

Select Variables

Select the variables which values you want to save/load to/from file. Use Up and Down arrows to
set the order of appearance in which values are defined in the text file.

Send Custom Commands

Send the defined list of commands to the print engine for execution.

Commands: Enter the commands in the text area.

-55-


http://www.w3schools.com/
http://www.python.org/download
http://sourceforge.net/projects/pywin32
http://www.python.org/
http://www.python.org/
http://kb.nicelabel.com/index.php?t=faq&id=204
http://kb.nicelabel.com/index.php?t=faq&id=204

Edit: Click on the Edit button to open the Expression Editor that will help you define the script of
custom commands.

You can also include variables in the commands. Just type in the variable name and enclose it with
the square brackets.

For example: To print the number of labels as specified in the variable Quantity, the print com-
mand should look like PRINT [Quantity]

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Note: For more information about commands refer to the help or user guide.

Send Data to TCP/IP

Define the sending of data to the TCP/IP port.

Destination: Define the destination to which you wish to send the TCP/IP data. If you only provide
the address and not the port number, the port will default to 80. Click on the detailed settings button
to enter the host name or port number separately, or to connect them with a variable.

Content: Set the data to be sent to the TCP/IP port.
Encoding: Set the encoding data

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started only
if condition returns True as the result of the expression.

Set Printer

The action defines the printer name that you want to use for label printing. This setting will over-
ride the printer setting that were set directly on the label.

Note: This action is useful, if you want to print one label file to several different printers without
the need for creating duplicated label files linked to different printers.

Printers: Define fixed name of the printer or select the variable name containing the name of the
printer.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression (this setting is only available in the
advanced Action Editor mode).

Set Variable

The actions sets the defined value to the selected variable.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.
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Translate Form

This actions will change all strings in the user interface and replace them with translations from
the selected language. Beforehand you have to translate the source files in the translation file that
application will generate for you. The translation file is automatically generated and contains
source text from all text content on the form.

Language: Define the fixed or variable name of the language. When this action will execute, it
will look into the file with translations and change the user interface in that language.

Translation file: Select the file that will contain the source strings and translations into various lan-
guages. This is a structured text file, similar to CSV (comma separated values).

o Create translation file: If you are creating new form project and do not already have the
translation file, click this button to create the initial translation file.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

For more information, See "Translating Forms" on page 65.

Acquire Image

TWAIN device: Select your TWAIN device from the list and set its advanced options. The Test
command displays a test with a preview of the Acquire Image action.

Note: Depending on the TWAIN device that you are using, some of the options may not be
applicable or available.

Settings: The file name options must be set for the action to perform. Assigning an image to the
variable is optional.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Verify License

This action allows the user to insert a license check to the trigger.
o Ifthe entered Solution ID number is not the same as the ID of the application, no actions
will be executed.

« If'the entered value is 0, actions will be executed if any valid license is found.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

View Log File

This action opens the printing log file for the current workstation. As such, the button with this
action offers access to the reprinting function, where past print jobs can be selected in the log file
and reprinted.

Reprinting:
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1. Define how many labels should be printed
2. Select the printer for the reprinting

3. Select the individual labels for reprinting in the list.

Note: If many labels are listed, you can use the search function to locate the label that you wish
to reprint.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started
only if condition returns True as the result of the expression.

Write Data to Serial Port

Define how the data will be written to the serial port.

The data sent to the serial port is stored as a fixed value or in the generated variable. You can use
the value of the variable directly on the label or use it in some other action in the form (like Visual
Basic script if additional data-manipulation is required).

Serial Port Settings: Define the properties of the serial port where you have attached the serial
device. The parameters in this dialog box have to match the settings on the device. Refer to the
documentation of your serial communication device so you will be able to specify the correct com-
munication parameters. If the settings on the device and in the software do not match, com-
munication will not be possible.

Data: Set the data to be sent to the serial port as fixed data or data from a variable. Type in the set
of characters that must be sent to the device. Click on the small arrow button on the right to display
list of all available special characters.

Condition: This is a scripting boolean expression. Only two results are possible (True and False).
Use this option to enable current action only when some term is met. The action will be started only
if condition returns True as the result of the expression.

Automatic Repositioning of Objects in
the Resized Form

Changing the Size of Multiple Objects
Simultaneously

1. Select all objects that you want to resize.

Note: Press and hold <Shift> key while clicking on the objects to select mode than one object.

2. Select the command Size from Transformations menu.
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Importing Variables from the Label

1. Select the command Get Variables from the Design menu.
The Select Label File dialog box opens.

2. Select the label files from which you want to import the variables.

3. The prompted variables that exist in a label file are available on the form. These variables
can now be connected with specific objects on the form.

Note: You can also import the database variables from the labels. Just make sure to tick the
option Use database variables defined in the label file.

If you do not want to manually import variables, use the New Form Wizard.

Note: Avoid using the same variable names as are the names of the internal variables in the
application, like Date, Time or Username.

Linking Object with Variables

METHOD 1

1. Place a fixed object on the form.

2. Double click the object.
The properties of the object open.

3. Go to the Contents tab.
4. Select the Variable value in the Contents combo box.

5. Select the appropriate variable from the list of variables.

Note: If there are no variables in the list, click on the New button and create a new variable or
import variables from the label. Then repeat the process from step 1.

6. Click on the OK button.

METHOD 2
1. Click on the small arrow button next to the object icon in the toolbox.
A context menu will display.
2. Select the option Use Existing Variable.
3. Select the variable from the list.

Note: If there are no variables in the list, click on the New button and create a new variable or
import variables from the label. Then repeat the process from step 1.

4. Click on the form where you want to position the object.
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Printing a Label Which File Name is
Read from the Database

1.
2.
3.

Create new form.
Select the command Get variables from the Design menu.

Browse to one of the labels you want to print and click on it.
The variables from the label will be imported on the form.

Note: All labels that you want to print using the suggested approach must have defined the vari-
ables with the same name.

4.
5.

Select the option Variables in the Data menu.

Click on the Add button to define one local variable that will contain the name of the
label file that should be opened.
Name the variable Label.

6. Select the Database Access in the Data dialog box.

7. Click on the buttons Wizard to create a connection to a database that stores the label

10.

11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

names. Select the option I want a table object in the database wizard.

Double click the table object.
Table properties will open.

Go to the Columns tab.

Make sure the variable Label is linked to the database field containing the name of the
label.

Click on the OK button.

Place a button object on the form.

Double click the button object.

Go to the Actions tab.

Click on the Edit button.

Insert the action Open label to the right pane.
In the action properties select the option Variable label file name.
Select the variable Label.

Click on the OK button.

Define the rest of the actions for the button.
Click OK to return to the form.

When you select a record in the table, the label name will be saved in the variable Label and the
appropriate label will be opened and printed.
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Printing Two or More Different Labels

If you want to print more labels from single click on the Print button, do the following:

Make sure you are in the Design mode.

Double-click on the Print button on the form.

Go to the Actions tab.

Click on the Edit button to open Actions Editor window.

Define another command Open label and select the other label file you want to print.
Define the command Print label under the second Open label command.

Click on the OK button to close the Actions Editor window.

Click on the OK to return to the form.

© Nk w D=

When the user runs the form and clicks on the Print button, each of the Open label commands will
print separate label file.

Quickly Designing and Testing the Form

1. Select the command New Form Wizard from the File menu and complete the wizard.
The result will be working form file based on the selected label file.

2. Select the command Run in the Design menu to start the form.

Note: You can also click on the button to start the form.

3. Enter all the necessary data values and then click on the Print button to start printing
labels.

Note: In addition to the usual use of <Tab> button to skip between fields, <MadCap:variable name-
e="Variables.Module-Form" /> it is possible to use the <Enter> key which performs the same func-
tion.

Changing the Focus of the Objects

Every object that is currently active in the running form has the focus. If the object has the focus,
you can use it. You can type in the data in the edit field. You can select pre-defined data from
combo box. You can press Enter to execute the actions in the button.

All objects in the form are organized in the tab order. This is the object order of appearance in
which the focus moves. Focus moves from the first object in the tab order list to the last one, then
the focus is moved to the first object and the cycle repeats.

To change the focus of the objects during the form design, you have the following options:

Pre-define the tab order.
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1. Select Design > Tab Order.

2. Use the Up and Down arrow buttons to change the object order of appearance. The top
object is the first in the tab order. The tab order is saved with the form.

Note: If you do not change the tab order, the default tab order is the order in which you put the
objects on the form.

3. To change the object focus while the form is running press the Tab (tabulator) key. Each
press of the Tab key will move the focus to the next object in tab order.

Use the action "Move Focus to Object" in the button.

1. Open the properties of the Button object.
2. Go to the Actions tab.
3. Click the Edit button.
4. Define the action Move focus to Object.

Note: If you do not see the action Move focus to Object listed, click the Advanced button to
show all available actions.

5. In the action you have two available options:

o Move the focus to the first object in tab order.

o Move the focus to some particular pre-defined object.

Note: You can also use the action Move focus to Object in the automatic events (File -> Form
Properties -> Events).

Changing the Screen Position of the
Running Form

When you run the form that you have created, by default it will run in the maximized mode on the
default display. You do not have to run the form in the maximized mode; you can center the form

on the desktop or current screen.

Do the following:

1. Select File -> Form Properties.
2. Go to Appearance tab.

3. Select the option Normal.
Now you can set the form dimensions, centering and offsets on your own.

4. Select the appropriate option for the Position and Size section.
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Changing Object Visibility

You can control many object properties on the form, including object visibility or object state
(enabled/disabled state). The interface to the form object is exposed through the action Set object

property.

When this action executes in the runtime, it will adjust a particular object property. The object will
immediately respond and change its state.

The action can be executed from the chosen event, such as onButtonClick (actions execute when
the user clicks a button), onFormLoad (actions execute when the form loads), oneV ari-
ableChange (actions execute when the particular variable changes its value), and other.

To hide the object on the form, do the following:

1. Double-click the object you want to hide.

2. Go to the Advanced tab and remember the Object Name.
3. Click Cancel.
4

. Decide what should trigger the object to hide and open the actions editor. For example, if
a button should hide some object, double-click the button, go to the Events tab, and click
Actions button.

5. In Actions Editor dialog box, navigate to the Other section and drag & drop the Set
object property action in the action list.

In Object name drop-down box, find and select the object name remembered in step 2.
In Property drop-down box, select Visible.

In Value section, enter false in the Fixed value edit field.

o % =2

Click OK buttons until you close all dialog boxes.
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Action Properties [Set object property] Iﬁ
Object

}’3’ Define object name and the property you want to set,

Object name:
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Property:
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Value

sT  Define a fixed orvariable property value for the selected
/L object.

@ Fixed value

false

) Wariable value

Condition

Define the condition that must be met for action to be

executed. If no condition is defined, action always

executes,
OK l’ Cancel ]’ Help l

To show the object on the form, you would use similar approach as for hiding the object, just the
Visible property would be set to true.

Setting the Tab Order in Which the Data
is Entered

1. Select Design -> Tab order.
2. Select the order of the objects, click Up and Down arrows to adjust the tab order.

Note: You can also use keyboard shortcuts Alt + Up and Alt + Down to change the position of
objects in the list.

3. Click on the OK button.
4. Select Run in the Design menu to start the form.

5. Test the behavior of the tab order. As the user presses the <Tab> key, the focus advances
from one object to the other. The next object in the tab order is selected and becomes act-
ive.
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Translating Forms

Your form applications can automatically change the language in the user interface upon a certain
user action. This is done on-the-fly on the same form, without a need to open some other form with
hard-coded translation.

Typically, the form will have a drop-down box with language selection, or it will have country
flags. Selecting a language in the drop-down box, or clicking the country flag will change all Ul
strings into the selected language. When you build your application enabled for multi-lingual usage,
the list of all strings used in the application will be created automatically, and saved to disk in a
plain text file. When the application design has been done, you will have to have the strings trans-
lated to the target language, and your multi-lingual application is ready for usage.

For more reference, see samples installed with NiceForm.
Enabling the Application for Translation

You enable the form translation option whenever you use the Translate Form action anywhere in
the form, and configure it. The main configuration parameter is the name of the translation file.
This is a file that will contain the list of source strings, and the list of corresponding translations
to one or more languages.

You can have just one translation file to use for all forms in your project. In this case, simply ref-
erence this one file in all Translate Form actions that you have. Whenever you save the form,
NiceForm will update the translation file with new strings found in the UI. If you have removed
some of the strings, they will not be removed from the translation file. NiceForm will add new
strings in the file, but never remove the old strings.

The Translate Form action takes two parameters to define:

o Name of the translation file.

« Language name (ID). The Language ID is the language name coming from the first
row in the translation file. The language name in the translation file is user-con-
figurable. Make sure to use the same ID (name) in the action as you have defined in the
translation file. The language name can be fixed or variable, the usage depends on the
language selection type you will use in the form.

» Fixed name. For example, your form contains images of the country flags.
When the user clicks the flag, the form language is changed to language of that
country. The image object contains action Translate Form, with hard-coded the
language name. Such as "DE" for German language. NiceForm must find the
matching "DE" field in the translations file.

o Variable name. For example, your form contains a drop-down box with lan-
guage names. When the user changes the language in the list, the onChange
action for this object will execute the Translate Form action. The drop-down box
saves the user selection in some variable, which is used in the action.

Structure of the Translation File

The translation file is a text file with UTF-8 encoded data. It is similar to comma-separated-val-
ues (CSV).

The Formatting Rules

You have to pay attention to the following formatting rules :
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o The first line contains the ID of languages.

o The very first field is always named Source. You must not
change it.

o The names of the rest of the fields in the first row are user-con-
figurable. You can use the suggested names, such as "Language
2" and "Language 3", or you can change them to whatever
describes the language better, such as "German", "French",
"Chinese", etc.

o All lines that follow the first line are lines with the translations from the
original language. The first field contains the original string, the next
fields in the same line contain translation to other languages. The first
line specifies in which order the translation must follow the source
string.

o All values are enclosed with double-quote characters (").

o All values are delimited by a semicolon character (;).

« If you have multi-line text objects in the form, the newline (SCR><LF>)
will be encoded as special string SNEWLINES.

« Ifyou leave the translation empty, the Source string will be used

Sample of a Translation File

"Source"; "DE"

"&Print";"&Druck"

"Cus-—

tom-

1zeSNEWLINESyourSNEWLINESprinting$SNEWLINESforms"; "AnpassenSNEWLINESSieSNEWL:
"Printer:";"Drucker"

"Quantity"; "Menge"
"SAMPLE" ; "PROBE"
"Se&ttings";"Einstellungen"
"Translate";"Ubersetzen"
"www.nicelabel.com/solutions";""

Translating Strings

If you use the Translate Form anywhere in your form, all strings that you have in the form are
automatically saved to translation file whenever you save the form. This ensures that the trans-
lation file is always up to date with your form.

The translation file is Unicode-aware text file. You can edit it in any text editor, but you might
have troubles recognizing the fields, because their values are semicolon-separated and not
aligned one below another.

You can also open the file in a spreadsheet application, such as Microsoft Excel. In this case the
fields belonging to particular language will be displayed in the same column of data, and much
easier to edit. However, note that spreadsheet applications might no honor the input file struc-
ture. In this case you will have to reformat the data yourself after you have saved the translation
file.

For example, Microsoft Excel will save the translation file as CSV. The fields will lose the
double quotes around the values and will be delimited by comma (,) instead of semicolon (;).
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You will have to convert commas into semicolons and put double quotes around fields. This can
be done with a few search & replace actions.

Using Data from Database

1. Select the command Database Access in the Data menu.

2. Click on the Wizard button and follow on-screen instructions.
The database table will be defined on the label.
Database fields will be linked to the specified objects.

Once the database is available in the application, its fields can be used with any form object.

It is possible to use variables in SQL as parameters. The parameters in SQL are preceded by a
semicolon (:param_name). Variables used as parameters must have a default value that cor-
responds to SQL (a variable used as a parameter in place of the Date Field must have a default
value that corresponds to a date). DO NOT change the default values of variables used in SQL
after defining SQL. It is however possible, to connect those variables to an EditBox, creating a
form that knows how to filter data.

Using Distributed Printing

The application provides additional printing method. Apart from the regular printing to the local or
network-connected printers it is possible to enable true network printing. In this mode the applic-
ation does not connect to the print engine directly to print the labels but creates a batch command
.JOB file, containing necessary commands to describe the current print operation.

The .JOB file can then be either dropped on a specified network folder or sent to the server applic-
ation over TCP/IP network protocol.
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Automating the Software

Command Line Parameters

You can use the command line parameters to pass advanced commands to the form designer when
the application starts.

There are actually two form applications available (two EXE files). One is form designer, one is
run-time module that executes the designed form.

<Program Name>.EXE [file name] [options]
For designer:

The Program Name is

C:\Program Files\EuroPlus\NiceLabel 6\bin\nform6.exe
[file_name] Represents the full path and name of the form file to open.

[parameter] can be the following:

/off2xff If you start form designer with this parameter, you can convert the form
files from previous versions of the software (text .OFF file format) to newer
version (XML .XFF file format).

Single file conversion

If the application is run with "filename.off /off2xff" parameters then form
designer will convert file filename.off to the new format with the name file-
name.xff.

Note: If the file filename.xff already exists it will be overwritten without a
question.

Multiple file conversions

If the application is run with "foldername /off2xff" parameters then form
designer will convert all files with the .off extension in the specified folder
foldername to the new format with the .xff extension.

For run-time module:
The Program Name

is C:\Program Files\EuroPlus\NiceLabel 6\bin\nformé6rt.exe

[file_name] Represents the full path and name of the form file to start. In this case the user does
not see the form design option. He can use the form only.

[parameter] Run-time module does not have any command-line parameters.
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Technical Support

Online Support

You can find the latest builds, updates, workarounds for problems and Frequently Asked Questions
(FAQ) on the product web site.

For more information please refer to:

o Knowledge base: http:/kb.nicelabel.com

o NiceLabel Support: http:/www.nicelabel.com/support

o NicelLabel Tutorials: www.nicelabel.com/Learning-center/Tutorials

¢ NiceLabel Forums: forums.nicelabel.com

- 69 -


http://kb.nicelabel.com/
http://www.nicelabel.com/support
http://www.nicelabel.com/Learning-center/Tutorials
http://forums.nicelabel.com/

	Table of Contents
	Introduction
	About this manual
	Conventions used in this Manual
	Welcome to NiceForm

	Setting up the Application
	User Interface
	Basic and Advanced User Interface
	Keyboard Shortcuts
	Status bar
	Toolbars

	Form Security
	Locking Form


	Designing Forms
	Using Toolbars
	Using Database Toolbar
	Using Standard Toolbar
	Using Text Toolbar
	Using Toolbox
	Using Transformations Toolbar
	Using Variable Toolbar

	Working with Objects
	Working with Buttons
	Defining Actions
	Browse for File or Folder
	Close Label
	Define Printer Settings
	Execute Script
	Execute SQL Statement
	For Every Label
	For Every Record in a Table
	For Loop
	Import Data Into Database
	Load Variable Data
	Move Focus to Object
	Open Another Form
	Open Document/Program
	Open Label
	Print Label
	Read Data from Serial Port
	Refresh Database
	Refresh Previews
	Run Command File
	Save Variable Data
	Select Variables
	Send Custom Commands
	Send Data to TCP/IP
	Set Printer
	Set Variable
	View Log File
	Verify License
	Write Data to Serial Port
	Quit

	Creating the Button

	Working with Button Group
	Creating the Button Group

	Working with Check Boxes
	Creating the Check Box

	Working with Combo Boxes
	Working with Combo Box

	Working with Database Navigator
	Creating the Database Navigator
	Working with the Database Navigator

	Working with Database Search
	Creating the Database Search
	Working with the Database Search

	Working with Edit Fields
	Creating the Edit Field

	Working with Frame Objects
	Creating the Frame Object

	Working with List Boxes
	Creating the List Box

	Working with Memo Fields
	Creating the Memo Field

	Working with Pictures
	Creating the Picture Object

	Working with Previews
	Creating the Preview

	Working with Radio Groups
	Creating the Radio Group

	Working with Tables
	Create the Table Element
	Formatting Table Object
	Linking Fields with Variables
	Using Master - Detail Connection

	Working with Text Objects
	Creating the Text Object

	Working with Variable Prompts
	Working with the Variable Prompt

	Aligning Objects on the Form
	Moving and Resizing Objects
	Selecting Objects

	Working with Variable Data
	Contents Providers
	Contents Providers

	Working with Databases
	Database Wizard
	Database Wizard
	Database Wizard: Starting
	Database Wizard: Selecting the Database File
	Database Wizard: Field Usage
	Database Wizard: Select Fields
	Database Wizard: Field connections to variables
	Database Wizard: Additional Objects
	Database Wizard: Completing the Process

	Using Filters

	Working with Variables
	Editing Variables
	Internal Variables
	Types of Variables


	Defining_Actions
	TWAIN Advanced
	Actions Editor
	Advanced Options for Label Quantity
	Advanced Options for Load Variable Data
	Advanced Options for Save Variable Data
	Browse for File or Folder
	Close Label
	Define Printer Settings
	Execute Script
	Execute SQL Statement
	Filter Editor
	For Every Label
	For Every Record in a Table
	For Loop
	Import Data Into Database
	Load Variable Data
	Move Focus to Object
	Open Document/Program
	Open Label
	Open Another Form
	Other Actions
	Print Label
	Quit
	Read Data from Serial Port
	Refresh Previews
	Refresh Database
	Run Command File
	Save Variable Data
	Scripting Languages
	Select Variables
	Send Custom Commands
	Send Data to TCP/IP
	Set Printer
	Set Variable
	Translate Form
	Acquire Image
	Verify License
	View Log File
	Write Data to Serial Port

	Automatic Repositioning of Objects in the Resized Form
	Changing the Size of Multiple Objects Simultaneously
	Importing Variables from the Label
	Linking Object with Variables
	Printing a Label Which File Name is Read from the Database
	Printing Two or More Different Labels
	Quickly Designing and Testing the Form
	Changing the Focus of the Objects
	Changing the Screen Position of the Running Form
	Changing Object Visibility
	Setting the Tab Order in Which the Data is Entered
	Translating Forms
	Using Data from Database
	Using Distributed Printing

	Automating the Software
	Command Line Parameters

	Technical Support
	Online Support


